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Using the downloaded CRESH data 
  

 

This document should be read in conjunction with the guide on ‘How to use the availability profiles and CRESH web map’; pages 8 and 9 

demonstrate how to download the availability and harm data from the CRESH web map.  The following information provides practical 

examples of how to best use the data once it has been downloaded.  This includes building up the data into areas of interest and comparing 

neighbourhoods’ availability and harm rates.  
 

For further help and information in addition to this guide, or if you have any questions, please contact Nicola Merrin, Senior Coordinator 

(Policy and Research) on 0141 572 6295.   
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Preparing the data for use 
After clicking ‘Download Filtered Data’, an Excel spreadsheet will download and become available to view and save.   

All 14 variables available will download for the local authority you have selected or area you have searched for.  The variable names will be the same as is 

on the screen.  We recommend that you rename the variable names so that the spreadsheet is easy to understand.   

You should find the table on page 10 of the ‘How to use the availability profiles and CRESH web map’ document helpful for deciding which variables you 

are interested in, and renaming the variables.   

Example: Scottish Borders 
The spreadsheet below shows the CRESH data for off-sales (800m) within the Scottish Borders, with the variable titles renamed and some variables 

removed.    

 

For the alcohol mortality range, it is best to change this to a single figure representing the group within 

which the rate sits (between 1 and 5) (e.g. instead of ‘Group 1 (0 – 59.6)’ you would just have ‘1’).  This 

can be done manually or by using the ‘Text to Columns’ button on the Data tab.     

Some of the crime rate data for individual neighbourhoods is not available – these will be cells with a 

zero value.  To ensure these are not counted when calculating averages, it is best to delete any zero 

values within the crime rate column (leaving the cell empty).  You can do this manually or press Ctrl+H 

to replace 0 with nothing.  Make sure to click on ‘options’ and tick ‘match entire cell contents’.   

https://www.alcohol-focus-scotland.org.uk/media/310779/how-to-use-the-profiles-and-cresh-web-map.pdf
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Building up data zones into different areas of interest 

Intermediate zones 
The CRESH data provides the intermediate zone name and code for each data zone with the local authority selected.  To view the data by intermediate 

zone, see page 11 of this guide, which shows how to create a PivotTable.   

Electoral wards 
You can find the data zone codes and names for those that sit within electoral wards by using the Scottish Government statistics website.  By selecting the 

local authority and then choosing the ward name, you can save and download the data zones within that ward.  

Example: East Berwickshire 
Within the electoral ward of East Berwickshire, if you click on ‘2011 data zones’, a list of the data zones within 

this ward is provided.  

 

Click on ‘add to data cart’ at the bottom of the list to download the list of datazones for this area. 

 

 

Then click on ‘data cart’ at the top right hand corner of the screen. 

 

 

 

 

 You then click on ‘save cart’ and download the data by clicking on the ‘CSV’ button.  

 

 

 

  

http://statistics.gov.scot/atlas/resource?uri=http://statistics.gov.scot/id/statistical-geography/S92000003
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This downloads a spreadsheet and gives the names of the data zones within this electoral ward.  

 

 

 

 

 

 

 

 

You can then copy and paste these data zone names into the spreadsheet that holds your downloaded 

CRESH data. 

 

 

 

 

 

 

The next step is to filter the CRESH data to only show the data for the neighbourhoods 

within this list.  See page 5 (‘Sort the data’) for how to do this.   
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Localities (by postcode) 
The most accurate way to find out the data zones of a locality is by postcode.  You must of course know the postcodes for each locality first, which should 

be available from the relevant Health and Social Care Partnership or Community Planning Partnership.     

Look up the data zones for the postcodes 
You can find the data zone codes for the postcodes you are interested in by using the SIMD postcode lookup spreadsheet (‘Look-up: Postcode to SIMD 

rank’). 

Once downloaded from the Scottish Government website, the spreadsheet allows you to enter postcodes (you can copy and paste from a list) and it 

automatically populates with information from the Scottish Index of Multiple Deprivation, providing the data zone code (first column after the postcode).  

1. Paste the postcodes into the postcode 

finder (column A)  

 

2. Remove the duplicates (many of the 

postcodes will have the same data zone) 

 Highlight the cells with the data 

zone codes 

 Go to the Data tab and click on 

‘Remove Duplicates’ 

 On the pop up, choose 

‘Continue with current 

selection’ and click on ‘Remove 

Duplicates’ and then click OK. 

 

 

 

3.  Copy and paste (as values only) the list of datazones that are populated by the 

spreadsheet in column B into your main spreadsheet  

 

 

 

 

http://www.gov.scot/Topics/Statistics/SIMD/Look-Up
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Filter the CRESH data to show only those in the area of interest 
1. Add another column within the spreadsheet with the CRESH data, and name this the area of interest e.g. Berwickshire.  In the example below, this 

has been  

2. In the first cell of that same column, use the ‘countif’ formula to count whether that data zone is within the area of interest.  The example below 

shows the formula ‘=COUNTIF($Q$2:$Q$33,A2)’ used within cell E2    

 The first part is the range of datazones you are interested in (what you pasted over, column R in this example) and the last part is the first 

cell in the data zone code column (A2)   

 If you have the data zone names instead of the codes, you would select the first cell in the data zone name column (e.g. B2).   

 The $ signs are there so that it is always these cells that are used.  

3. Copy this cell and paste all the way down so that the formula applies to every row.   

4. This column will give a 1 if the datazone is within your area of interest. You can then filter this column to only give you the data for this area by 

only selecting cells that have a 1.   
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Comparing neighbourhoods (at data zone level) 
The data can best be used to compare neighbourhoods’ alcohol availability and harm rates. This can be done very simply at the neighbourhood (data zone) 

level, and a PivotTable can be created if you want to look at more intermediate geographies (e.g. intermediate zones, elected wards, HSCP localities).   

Comparing neighbourhoods at data zone level 
The data for the neighbourhoods in the area you have selected can be easily manipulated to show the neighbourhoods with the highest rates of alcohol 

availability and harm.  The first step is to sort the column with the number of alcohol outlets from highest to lowest.   

Sort the data 
To be able to easily sort and filter the data, highlight the top row of cells and click on ‘Sort and Filter’ at the top right hand 

corner of the home tab, and then ‘Filter’.  

You can then click on the arrow on the variable name and choose to ‘Sort Largest to Smallest’ 

 

 

The data will then sort so that the neighbourhoods with the 

most outlets around the neighbourhood centre will be at the 

top, and those with the least will be at the bottom.  

  

The next step is to highlight the cells where the value is higher 

than the local authority and/or Scottish neighbourhood average 

for each of the variables (number of outlets, alcohol mortality, 

hospitalisations, crime rate).  To do this, you must first add the 

averages.   
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Add the local authority and Scottish averages  
The average availability and harm rates for neighbourhoods across Scotland and/or the local authority can be added to the bottom of the data 

downloaded from the web map.  

The average number of outlets within 800m of the population centre for total outlets, on-sales outlets and off-sales outlets can be found on page 2 of the 

local profile; if the distance from the population centre selected is not 800m, the averages can be calculated from the data.  The average harm rates for 

neighbourhoods across the local authority and Scotland as a whole for hospitalisations and crime rates are found on page 4 of the local profile. 

 

Example: Scottish Borders 
The spreadsheet below shows where the Scottish and local authority averages have been added for these variables.  The cells that are above these values 

can now be highlighted.  

 

  

https://www.alcohol-focus-scotland.org.uk/campaigns-policy/availability-and-licensing/alcohol-outlet-availability/
http://www.alcohol-focus-scotland.org.uk/campaigns-policy/availability-and-licensing/alcohol-outlet-availability/http:/www.alcohol-focus-scotland.org.uk/campaigns-policy/availability-and-licensing/alcohol-outlet-availability/
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Highlight above average availability and harm rates 
The best ways to highlight cells that are above the average values is to use conditional formatting.  After selecting the cells you are interested in (e.g. all of 

the cells that hold the data on the number of outlets), click on ‘Conditional Formatting’ on the home tab, ‘Highlight Cells Rules’ and then ‘Greater Than’ as 

shown below: 

You can then enter the average value above which you would like to highlight in red the cells (the 

highest average, most commonly the Scottish average).  

The same process can be followed for highlighting cells that are between the Scottish and local 

authority average by choosing ‘Between’ when doing the conditional formatting, and entering the two 

values.  You can choose to highlight it yellow.   

For this example, we would highlight in red anything that is greater than 5.4 and highlight in yellow 

anything between 2.5 and 5.4.   
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The same process should be followed for the alcohol mortality, hospitalisation and crime rate variables.  You may also wish to highlight cells within 

income deprivation column that are lower than 3, to highlight neighbourhoods which are income deprived (choose a different type of highlighting for this 

one, e.g. orange).  

 

This means you can clearly see which 

neighbourhoods have higher than average levels 

of both alcohol outlet availability and harm rates.  

It also allows you to see at a glance which 

neighbourhoods are deprived.  

 

For example, the town centre of Galashiels North 

has the highest number of off-sales outlets within 

the local authority, as well as higher than Scottish 

average alcohol mortality, hospitalisation and 

crime rates. It is also income deprived.    

 

There are other areas where there is high off-

sales availability but low levels of harm (e.g. 

Millers Knowe in Hawick Central), and vice versa 

where there are low avaialbility and high levels of 

harm.   

 

 

This is where local knowledge and other sources of evidence can be very helpful. 
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Comparing neighbourhoods (higher than data zone level) 
The easiest way to compare availability and harm rates for neighbourhoods within geographical areas larger than data zones (e.g. intermediate 

geographies, HSCP localities, elected wards) is to create a PivotTable.  This produces averages for each variable, which can then be sorted and highlighted 

as shown in the last section of this guide.  

This can be done by clicking the ‘Insert’ tab, and then selecting ‘PivotTable’ on the left hand side.   

You will be asked which data you want in the table, and whether this should go in a new 

sheet. The options that come up should be fine – click ok.    

A new sheet will open on the spreadsheet.  This will be blank, waiting for you to select the 

fields you want to show in your table.  On the right hand side, the column headers will be 

listed for you to choose which ones to add to the table.  

 

You should select the name of the neighbourhood (data zone name) first (these will form the rows), followed by the 

number of outlets and the harm data you would like to compare.   

 

The geographical area should be in the ‘rows’ section.   

 

 

 

Every other variable should be within the ‘values’ box in the bottom right hand side.  You can simply drag and drop 

the fields if they are in the wrong place.   
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The PivotTable automatically provides the sum of the different fields – you should change this to the average to see the average number of outlets and 

harm rates for the neighbourhoods within each area.  Right click anywhere on the column and go to ‘Summarize Values By’ and then choose ‘Average’.   

 

Do this for each column.     
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Rename ‘Row Labels’ to the name of the type of area you are looking at (e.g. ‘Neighbourhoods’, ‘Intermediate Zone’, or ‘HSCP Localities’).   

You should end up with something that looks like this, for HSCP localities as an example: 

 

 

 

 

 

 

 

 

 

 

 

 

 

The variables chosen for this PivotTable were HSCP Locality, Intermediate Zone name, and Data Zone name (in the rows) and the availability and harm data 

(in the columns).  You can see the average for all of the neighbourhoods within each locality.   

We can use this table to say that the locality with the higher off-sales outlet availability is Teviot, which also has the highest crime rate and has higher than 

average hospitalisations as compared to the local authority.   

You can also look at each locality in detail, by clicking on the + button to show the data for the more local geographies of intermediate zone and data zone. 

This shows more local areas within the locality (intermediate zones and data zones).   You can see above that Berwickshire has 6 intermediate zones, and 

within the IZ of Berwickshire Central, there are 5 data zones.    


